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Abstract 

 

Land use change impacts surface water-balance, water quality and water demand. On the 

other hand, water resources degradation also posing threat to the society due to over-

utilization which results insufficient water facilities for the growing demand. The present 

study focuses on past land use change and also predicted future land use change. For this, the 

land use/land cover maps of the study year for the years 1993, 1997, 2005, 2011 and 2017 

have been prepared using ArcGIS and ERDAS. The results showed urban area change from 

1993-2017 is 8.09 km2, which is 3.7% for 24 years. So, urban area is growing at a rate of 0.33 

km2/year. The future land use predicted using Land Use Change Modeler in TerrSet Software 

in which Markov Model used. The results showed urban area change from 2017 to 2050 is 

58.63 km2, which is 26.95% for 33 years. So, urban area is increasing at a rate of 1.77 

km2/year. 

Comparing capital city with other bifurcated state capitals is very useful to understand the 

water scarcity and management problems faced by the cities with the unexpected outgrowth 

of population and urbanization. An attempt made to check how population changes in 

bifurcated state capitals to Amaravati in which Ranchi city forecasted population matches 

with the estimated master plan population of Amaravati which significantly can study the 

changing patterns of both cities with respect of water balance and water resources 

management. Water scarcity, which emerges when demand exceeds supply, poses 

unprecedented challenges to human and ecological security. 

SWITCH approach helps to make the city more sustainable in future with learning alliances, 

theme-city level strategic planning studying theme level city water balance, water drain and 

water economics. The suggested urban water resources management plan could help the city 

for not running towards more sources and reduce the water demands by increasing water 

reuse efficiencies with SATs, aquifer storage & recovery, engineered buffered technologies; 

implementing water demand management options like installing DMAs, systemization of 

water supply system, water metering, water saving devices, rain water harvesting at roof tops, 

green and brown buildings, constructing green infrastructure, grey water reuse; water 

sensitive urban design through River Krishna restoration using eco-hydrology principles, etc. 

The results of the study will be important input for planners for an upcoming city to 

understand and analyze the urban water balance for future with some proper measures taken 

at planning stage itself. 
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Chapter 1 

INTRODUCTION 

1.1 General 

Urbanization is one of the most concern areas on present days since it is alarmingly 

increasing due to population growth. Urbanization impacts the availability of water upon 

changing land use and land cover, which it affects the watershed hydrology thereby 

increasing water demand (Feng Wu et al., 2015). The increased surface impervious cover due 

to urbanization also changes the hydrologic, or flow, river regimes thereby causes decrease in 

infiltration rates leading to increase in flash floods. Because of all these, the cities are not able 

to face these situations due to incapable sewerage facilities, insufficient drainage system, 

which at the time of planning and design, they do not consider these factors leading to severe 

urban flooding problems now-a-days. 

1.2 Impact of Land Use/Land Cover on Water Resources 

 

Land is a constrained regular asset and has an aggressive nature among its users. The change 

in land use absolutely gives numerous financial and social openings, however they 

additionally come at the expenses to sustenance creation, freshwater assets, woods assets, and 

atmosphere and air quality. Land use change can also alter surface water-balance; water 

quality and water demand (Omaid Najmuddin et al., 2017). Furthermore, land use change 

affects regional climate including temperature and air quality through its impact on net 

radiation, energy division, breaking precipitation into runoff, soil-water and 

evapotranspiration. 

Land use change has been determined both by regular and anthropogenic variables. Changes 

in land cover have been occurring since the world came to exist. Nevertheless, in the current 

past, elements of quickly developing populace, urbanization and modern advancement, 

environmental change and fast mechanical improvement have expanded the pace of land use 

change. During the last five decades, world has experienced a significant spatial expansion of 

urban areas, which is mainly caused by increased population, changing economy and better 

living facilities (Omaid Najmuddin et al., 2017). So, land use management is of great 

importance because of its critical role in human development and social well-being. 



2 

 

On the other hand, water resources degradation also posing threat to the society due to over-

utilization, insufficient water facilities for the out growing demand and non-usage of over 

flooded water because of lack of resources management in the urban cities which will get 

wasted. 

1.3 Climate Change Impact on Water Resources 

Climate change assumes an imperative part in each field particularly most worry for 

hydrology designers and water assets supervisors. Climate change has possible effect on both 

the long-term availability and the short-term variability of water resources (Sheila M. 

Olmstead, 2014). The climate change impact on urban areas and river basins is most extreme 

significance since these are most influenced and most vital worries for each nation. Potential 

provincial effects of climate change could incorporate expanded recurrence and size of dry 

seasons and surges, and long-haul changes in sustainable water supplies through changes in 

precipitation, temperature, moistness, wind power, nature and degree of vegetation, soil 

dampness and overflow (Sheila M. Olmstead, 2014). 

Because of climate change, the access to fundamental urban administrations, particularly 

those connected to water supply, is relied upon to end up more troublesome, exacerbating 

natives' personal satisfaction (L. Bonzanigo et al., 2014). As everything is linked with the 

environment and climate, studying the effect of climate change on urban cities and its effect 

on water resources will be more useful for future. These considerations should be taken at the 

planning stage of future smart cities in order to overcome water problems, as the world is 

running towards smart cities development. 

1.4 Urban Water Demand and Water Scarcity Problems 

 

Urban water demand relies upon the working of urban setting and its monetary limit. (Collins 

et al., 2000). It is assessed that by 2050, half of India's populace will live in urban zones and 

will confront intense water issues. In India, 80% of urban populace has access to drinking 

water yet just 20% of the accessible drinking water meets the wellbeing and quality standards 

set by the WHO. (Singh, 2000). 

Water shortage, which rises when demand surpasses supply, postures uncommon difficulties 

to human and natural security (Cheng and Zhao, 2006). Water shortage can possibly turn into 

a significant issue later on because of changes in atmosphere, populace and condition. The 

common water worry in numerous creating nations isn't just because of the constrained water 
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sources yet different variables like poor dispersion efficiencies through city systems as a 

result of high water loss rate from conveyance frameworks and wastefulness of 

administration of water supply frameworks. 

To overcome water scarcity problems, one should not go for supply management options by 

increasing the number of water sources but instead they should adopt demand side 

management options for better water management for increasing population to satisfy the 

water demands by using water efficiently. 

1.5 Research Gap/Rationale 

 All most all researchers study land use effect and water resources studies on river basin 

catchments, watersheds, and existing urban areas but few on future planned cities or 

declared smart cities 

 No studies conducted on Amaravati capital city, which is declared as Andhra Pradesh 

capital on 2015 and also declared as smart city by union govt 

 

1.6 Objectives 

The present study was undertaken with the following objectives: 

 To analyse the land use/land cover data of the study area for different years (2017, 2011, 

2005, 1997, 1993) 

 To predict the future land use/land cover up to 2050 

 To assess the population and existing water sources of Amaravati 

 To prepare urban water management plan for sustainable development of the study area 
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Chapter 2 

REVIEW OF LITERATURE 

 

2.1 Land Use/Land Cover Studies 

The conceivable impacts of land use/land cover change and precipitation on spatio-temporal 

changes in extreme stream flows inside the watershed had been studied from 1992 to 2011. 

The outcomes demonstrate that land use and precipitation influenced stream discharge. The 

expanding urban advancement shows chance of about 37% of influencing outrageous stream 

streams inside the watershed. They presumed that inside the watershed, Land use/land cover 

change is the real supporter for expanded stream flow and potential flooding (Lei et al., 

2017). 

Dynamic of Land System (DLS) model can be used to simulate land use/cover and this study 

was simulated for the years of 2020 and 2030. For this reason, different financial and bio-

physical datasets were arranged and after that incorporated into the model under three unique 

situations i.e. base line, monetary advancement and ecological insurance. They have utilized 

land use information, topographic information; soil characteristics information; climatic 

information and financial information. DLS model is a gathering of projects that mimics the 

land use flow in view of the given situation by breaking down reasons for the progression of 

land use examples to help land use administration choices.  

To analyse the casual relationship between driving forces and the dynamics of land use 

change, they applied the logistic regression modelling using STATA software. 

Although, DLS model has an effective framework for simulating the land system dynamics, 

the results should not be considered as the exact projection of future events. However, the 

results of this model suggest possible future patterns of land use change (Omaid Najmuddin 

et al., 2017). 

2.2 Climate Change Studies 

The connection between climate change and water assets, water circling reaction of climate 

change was reviewed in this study. They condense some investigation strategies for 

dissecting the effects of climate change on hydrology and water assets, for example, age 

innovation for climate change situation and hydrologic recreation. They expressed that the 
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impact of climate change on water assets is a direct result of the water and water quality 

changes that caused by atmosphere factors (for the most part incorporates precipitation and 

temperature changes) and the examination of the effect of climate change on hydrology and 

water assets framework is principally through the basin temperature, precipitation and 

vanishing change caused by climate change, for example, to foresee the pattern may 

increment or abatement the overflow and its watershed water supply impact (Nan, Y. et al., 

2011). 

The current writing on the reasonable monetary effects of climate change, acting through 

water free market activity impacts in particular waterway bowls, and the capacity of 

adjustment to moderate those effects was reviewed in this study. Likewise, audit what is 

thought about the reactions of water clients to water costs, non-value water preservation 

strategies, water exchanging, interest in and activities of capacity and movement framework, 

and trans boundary water allotment instruments. He described the potential commitments of 

connecting existing and new experimental research on water asset adjustment with IAMs 

(Sheila M. Olmstead 2014). 

The analysis of the effects of future climate change on water assets and extreme streams 

utilizing the Coupled Land surface and Hydrology Model Systems (CLHMS) was done and 

this model was created to foresee the 21st century climate change and water cycle change. 

The CLHMS incorporate a vast scale land surface model LSX and a fine grid circulated 

hydrological model HMS. The coupling between the LSX and HMS depends on anticipated 

soil dampness and surface water depth. The land-surface models incorporate two-layer 

vegetation model, three-layer snow model and six-layer soil model; the hydrological models 

incorporate terrestrial hydrologic model (THM), groundwater hydrologic model (GHM) and 

channel ground-water interaction (CGI). 

The outcomes exhibit that most of the GCMs have a better limit than imitate the temperature 

than that of precipitation. In perspective of the simulation capacity evaluation, the RCPs 

situations informational collection of perfect GCM was slant changed and used to drive the 

CLHMS. The effects of future climate changes on water assets and outrageous streams was 

inspected and gave diverse outcomes with utilizing RCPs on precipitation patterns and 

extraordinary flood occasion patterns increment or lessening on time scale (Yongnan Zhu et 

al., 2016). 
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2.3 Combined Land Use/Land Cover and Climate Change Studies 

The Dynamic Urban Water Simulation Model (DUWSiM) built up to join the urban water 

balance ideas with the land use elements model MOLAND and the climate model LARS-

WG, giving a stage to long haul planning of urban water supply and water demand by 

breaking down the impacts of urbanization situations and climate changes on the urban water 

cycle. 

This model gives the usefulness to surveying the liveability of brought together and 

decentralized water supply and water request administration alternatives in view of 

anticipated water request, storm water and wastewater age, entire life cost and vitality and 

potential for water reusing on an everyday time step. It joins urban land use change and 

climate change situations on a yearly basis for up to 20 years into the future. 

The model offers the additional preferred standpoint of permitting examination of water 

administration choices in view of perceived manageability pointers, for example, entire life 

expenses and vitality, water request, accessible supply and wastewater generation. DUWSiM-

WB runs on two-time steps; a daily time step (all water related processes) and an annual time 

step (Land use changes). 

Results demonstrated that DUWSiM predicts storm water runoff and water request with great 

exactness. Future research potential outcomes incorporate extension of DUWSiM by fusing 

the displaying of groundwater, contaminant adjusts and a disaggregated water demand 

module which would catch a greater amount of the many-sided quality engaged with 

evaluating water request. Future research could give understanding into how urban water 

assets effect on urban improvement, which would enable further advancement of DUWSiM 

to incorporate demonstrating the impacts of water assets on urban advancement designs 

(Lars Willuweit et al., 2013) 

An incorporated demonstrating system connecting urban-land development, water-

assignment, and hydrological forms and inspect the joined effects of the adjustments in land 

use/land cover and financial movement because of urbanization and in climatic conditions on 

water assets was used in the Heihe River Basin over the time of 2010-2050. 

The integrated framework can fill in as a valuable device to look at the effect of different 

advancement situations with the point of effectively allotment water assets and expanding 

water utilize proficiency. The hydrological impacts of changes in land use land cover and 
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climatic conditions were displayed utilizing a basin-scale hydrological model, generally 

utilized as a part of the evaluations of water amount and quality. 

Forecasts of urban development and urban land extension at 2050 were performed utilizing 

ordered weighted harmonic averaging (IOWHA) administrator mix model and dynamics of 

land system (DLS) model separately. Future water interest for the forecasted urbanization 

was resolved and water portion was enhanced and surveyed utilizing a computable general 

equilibrium (CGE) model. The integrated framework developed here can be used for other 

basins elsewhere with similar characteristics of the mentioned study area (Feng Wu et al., 

2015). 

2.4 SWAT Studies on Water Balance 

The pertinence of SWAT model for the territory which experiences hydrological information 

shortage was assessed. The model was utilized to survey the effect of precipitation, 

temperature, and CO2 focus changes on the water balance of the watershed. They expressed 

that there is a need exists for watershed model improvement in the windward, wet side of the 

islands that will be extremely delicate to climate change, as a basic assignment for a 

coordinated water assets administration, climate change affect appraisal, and versatile 

procedure to climate change. 

The study addressed two things – evaluate the applicability and suitability of the SWAT 

model for stream flow simulations under scarcity of hydrological data; assess the impact of 3 

different climate variables (rainfall, temperature and CO2 concentration) change on the water 

balance components in the watershed. 

The nature of existing precipitation information from the adjacent stations is imperative that 

is the reason they considered the little size of the watershed representing precipitation 

information changeability. Encourage change in modelling can be accomplished if great 

quality and well-represented climate information are utilized. Establishment of hydro-

meteorological stations to catch fluctuation inside the study site would help any further 

investigations. 

The water balance segments were sensitive to precipitation change when contrasted with 

temperature change and increment in CO2 fixations. All the more critically, the groundwater 

stream part will be contrarily affected by the anticipated precipitation and temperature 
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changes. They presumed that the anticipated situations may antagonistically influence the 

groundwater supportability of the watershed. 

Lastly, the adapted SWAT model is a useful tool for assessing water resources availability 

and assessing climate change scenarios provide useful information for evaluating the future 

freshwater availability and designing appropriate climate change mitigation measures 

(Olkeba Tolessa Leta et al., 2016). 

2.5 Water Demand Management and Low Impact Development Studies 

The rainfall time series in conjunction with appraisals of residential water appliance use 

created by Monte-Carlo re-enactment strategy and the model demonstrates that adjustments 

in the traits of family unit inhabitancy, rooftop territory, apparatus write and capacity volume 

of a solitary store reuse framework influences the water sparing proficiency was used. With 

combined grey water and rainwater, the storage size of range 0-100 litres shows the greatest 

rate of increase of efficiency. Further analysis showed that up to 80% savings of the WC 

flush water can be achieved with less than storage of 50 litres. He concluded the importance 

of small volume domestic water reuse systems are better solutions in the urban housing 

environment towards a more sustainable city (Dixon, A. et al., 1999). 

The importance of low impact development (LID) over traditional storm water design was 

stated in this study. Porous pavements are very much effective in infiltrating storm water 

runoff. He founded that the green roofs were able to retain more percentage of rainfall (an 

average of 63%) in the different variety of climates. The study showed that bio-retention and 

pervious pavements will able to infiltrate even with the presence of ground frost (Dietz, M.E. 

2007) 

The joined utilization of elective water supplies together with water effective machines can 

set aside to 77% or add up to consumable water utilize was demonstrated in this study. They 

additionally expressed that the utilization of rain water inside the home alone set aside to 

40% of consumable water utilize. Aside from water savings, waste water release sparing can 

be accomplished using water protection methodologies and grey water reuse. They revealed 

that the reusing grey water is most elevated for watering gardens and flushing toilets yet it 

dynamically diminished with expanding individual contact with grey water 

(Muthukumaran, S. et al., 2011). 
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The prerequisite of high determination end utilizes water utilization information to survey 

water funds in family units utilizing proficient gadgets and to see how reserve funds fluctuate 

between various socio-statistic bunches in the group has been highlighted in this study. They 

expressed that the smart metering has empowered the gathering of end utilize water 

utilization information. They presumed that savings accomplished through water demand 

management programs have a stream on advantage to the whole water and waste water 

framework by decreasing the pinnacle hour consumable water demand, diminishes normal 

and peak effluent loading to the waste water framework (Willis, R. M. et al., 2013) 

 

The complete literature review depicts that most urban saturated cities are facing water 

problems due to improper management of water resources and urban water demand. The 

climate change studies reveal that the effect of climate change variables will be more on 

water availability on rivers and precipitation. The Land use/land cover studies clearly showed 

the impact on water resources of urbanized areas. Various studies depicted the importance of 

demand side management to reduce the water demand and save the water.  

In the present study, an attempt made to prepare past and present land use/land cover maps in 

view of all these impact factors on water resources for a future planned sustainable smart city, 

Amaravati, capital city of Andhra Pradesh, because impact studies of land use/land cover, 

climate change on water resources and importance of water demand management options are 

not considered at planning stage by many planners. 

The study also incorporates the comparison studies of cities in view of population and 

drinking water scenarios to set some future goals for the planners and learn lessons from the 

cities facing problems on water sector and for not making the Amaravati city as water 

scarcer. 

Finally, the study recommended some water demand management options to be implemented 

to cut the number of sources of water supply which are planning to construct in future by the 

government of Andhra Pradesh. 
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Chapter 3 

STUDY AREA AND DATA 

 

3.1 Description of Study Area 

 

Government of Andhra Pradesh has set out on advancement of the new Capital City of 

Andhra Pradesh, which is envisioned to be the pioneer Smart City of India. It means to be 

world class and at standard with the guidelines put forward by nations such as Singapore. 

Proposed Capital City is named after historic site of Amaravati, known for its Buddhist 

culture that flourished from 400 BC to 1100 AD. The site is located on the southern bank of 

Krishna River in Guntur District at 16.54 N latitude and 80.52 E longitude. The elevation of 

this area ranges from 4 to 261 m and annual rainfall varies between 965 mm and 1222 mm. 

Areal extent of the Capital City is 217.50 sq.km which is carved out through voluntary Land 

Pooling System (LPS) of mainly green fields (agricultural land) and 29 existing village 

hamlets. Amaravati, capital city of Andhra Pradesh, declared as smart city on June, 2017. The 

urban sustainability framework set by the govt. for the capital city is presented in the Figure 

3.1. The study area map is shown in the Figure 3.2. 

 

Figure 3.1 Urban sustainability framework of Amaravati 
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Figure 3.2 Description of study area 
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3.2 Data Used 

Land use and land cover data for 1993, 1997, 2005, 2011 and 2017 were obtained from 

United Stated Geological Survey Database (www.earthexplorer.usgs.gov) with a resolution of 

30m. The path and row of the satellite images for the study area are presented in Table 3.1. 

The details of the different satellite images sensors, date of image taken are presented in 

Table 3.2. 

Table 3.1 Path and Row number of satellite images 

Path No Row No 

142 49 

 

Table 3.2 Different sensors and date of image taken for satellite images 

S. No Sensor Date of Image taken 

1 Landsat 8 25-03-2017 

2 Landsat 7 19-10-2011 

3 Landsat 7 11-05-2005 

4 Landsat 4-5 14-02-1997 

5 Landsat 4-5 11-06-1993 

 

The Digital Elevation Model (DEM) was obtained from NRSC-Bhuvan open data archive 

(www.bhuvan.nrsc.gov.in/bhuvan_links.php) developed by Indian Space Research 

Organization. Shape-file layers of Amaravati were obtained by digitized the master plan 

developed by Andhra Pradesh government using Arc GIS. Shape-file layers of India were 

obtained from DIVA-GIS open data source (www.diva-gis.org) and also from 

www.indianremotesensing.com. Census data of Indian government were used for comparison 

studies. The recent road lines base map of Amaravati was obtained from open data source 

through QGIS software. 

The software’s and Models used in the study are ArcGIS, ERDAS and TerrSet. 

 

 

 

www.earthexplorer.usgs.gov
www.bhuvan.nrsc.gov.in/bhuvan_links.php
http://www.diva-gis.org/
http://www.indianremotesensing.com/
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Chapter 4 

METHODOLOGY 

 

4.1 GIS Data Preparation 

Amaravati boundary shape file was prepared by digitizing the master plan using poly line 

editor tool in Arc GIS and it was projected in to UTM Zone 44N. The recent road lines base 

map of Amaravati was obtained in multiple layers as poly lines, polygons, points. The road 

line map should contain poly lines, the other features were deleted in QGIS software using 

editor tool. The Andhra Pradesh shape file was prepared from Indian shape file obtained from 

DIVA-GIS by selecting the all districts of Andhra Pradesh in attribute table and then made 

using clip tool in Arc GIS and given coordinate system as GCS 1984.  

4.2 Past Land Use/Land Cover Files Preparation 

The satellite images of Amaravati were downloaded from USGS Earth Explorer. The 2017, 

2011 images were obtained from Landsat 8; 2005, 1997 images from Landsat 7 and 1993 

image obtained from Landsat 4-5. The data from sensors was obtained in 12 single bands and 

single composite band of each time period image was prepared using stack tool in ERDAS. 

The image quality (Edge Enhancement) of five images was increased using convolution tool 

in ERDAS without changing the pixel size.  

The land use/ land cover classification maps can be prepared in three ways, supervised 

classification; unsupervised classification and combined classification. The present study 

adopted combined classification for better accurate results. Firstly, using unsupervised 

classification tool (present in Raster Tab) in ERDAS, the study classified the entire satellite 

image into 150 classes and converted in grey scale using grey scale color scheme options. 

Secondly, using Google Earth Pro, synchronized and linked with the satellite image, which 

was opened in ERDAS, select the pixels of specific class by holding left click, drag and move 

and assigned specific color using attribute table. Repeat the same procedure by identifying 

and assigning specific color to the specific classes. 

After this, the post correction procedure was followed to minimize the errors of classified one 

class pixels to another class by drawing a polygon around the error area and changed the class 

value using recode tool (present in Thematic map Tab) in ERDAS. The same procedure was 

followed for five different time period satellite images and finally obtained five land use/land 
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cover maps. The present study area land use/land cover classified into five defined classes, 

water; urban; agriculture; forest & plantation and barren land. 

4.2.1 Preparation of past land use change data 

The study area land use classified images were extracted from the whole classified satellite 

images using extract by mask tool in Arc GIS with the Amaravati boundary shape file.  

The change of pixels from one class to another class for the two different years was obtained 

using Matrix Union tool (present in Raster Tab-->Thematic) in ERDAS. This output file 

opened in Arc GIS and copied all the pixel values from one class to another class for the 

respective years in to excel and area was computed by multiplying the pixel count with 

spatial resolution (30X30) and unit multiplication factor to get in desired units (sq.kms). The 

percentage change of area for five classes for the respective years was also computed. 

The same procedure was used for all respective images and change analysis data was 

prepared for 1993-1997; 1997-2005; 2005-2011; 2011-2017 and 1993-2017.   

4.3 Future Land Use/Land Cover Prediction Files Preparation 

The future land use/land cover classification image was prepared using Markov chain Model 

by TerrSet Geospatial Monitoring and Modeling system software (Land Change Modeler 

(LCM)). 

The Land Change Modeler (LCM) was an integrated software environment within TerrSet 

oriented to the pressing problem of accelerated land conversion. In LCM, tools for the 

assessment and prediction of land cover change and its implications were organized around 

major task areas: change analysis; change prediction and planning interventions. The 

complete flow chart for visualization of LCM process is presented in Figure 4.1. 

 Change Analysis: Analyzing past landcover change 

 Transition Potentials: Modeling the potential for land transitions 

 Change Prediction: Predicting the course of change into the future 

The land cover maps used by LCM must be formatted to meet the following conditions: 

 The legends in both maps should be same 

 The categories in both maps should be same and sequential 

 The backgrounds in both maps should be same and have a value of zero 

 The spatial dimensions, including resolution and coordinates, should be same 
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Change Analysis, Model Training and Validation 

 

Figure 4.1 Flow chart for visualization of LCM process 

 

The default procedure for determining the amount of change that will occur to some point in 

the future was by means of a Markov Chain. 

Markov model was a stochastic model portraying a grouping of conceivable occasions in 

which the likelihood of every occasion depends just on the state achieved in the past 

occasion. Using the earlier and later land cover maps along with the date specified, Markov 
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figures out exactly how much land would be expected to transition from the later date to the 

prediction date based on a projection of the transition potentials into the future. Note that this 

was not a simple linear extrapolation, since the transition potentials change over time as the 

various transitions in effect reach an equilibrium state. 

The input files (called as variables) required for the prediction were Digital Elevation Model 

(DEM); Slope map; Distance_Urban map; Distance_Road map; 3rd degree polynomial spatial 

trend of change from all to urban map and latest land use/land cover image. All maps 

converted into .rst extension files using TerrSet and all were prepared as reclassified images 

using reclassify tool in Arc GIS.  

4.3.1 Preparation of input files 

4.3.1.1 DEM file 

The downloaded tiles of DEM from NRSC-Bhuvan were mosaic using mosaic to new raster 

tool in Arc GIS (present in Data Management Tools->Raster->Raster Dataset) and extracted 

using extract by mask tool with Amaravati shape file and then converted into projected 

coordinate system UTM Zone 44N. 

4.3.1.2 Slope map 

From the study area DEM file, the desired slope map was obtained using slope tool (present 

in Spatial Analyst Tools->Surface) in Arc GIS. 

4.3.1.3 Distance_urban map 

The latest land use map is reclassified into single urban class by assigning all class values as 

No_Data leaving only urban class using reclassify tool. Then with that output file, the 

distance_urban map was prepared using Euclidean Distance tool (present in Spatial Analyst 

Tools->Distance) in Arc GIS and kept the processing extent and masking same as Amaravati 

boundary shape file. 

4.3.1.4 Distance_road map 

Using the latest road lines map of Amaravati, the distance_road map was prepared using the 

same Euclidean Distance tool (present in Spatial Analyst Tools->Distance) in Arc GIS and 

kept the processing extent and masking same as Amaravati boundary shape file. 
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4.3.1.5 Third order polynomial spatial trend of change map 

With the two-land use/land cover images given as input in Land Change Modeler, TerrSet, 

the all to urban map trend was obtained in the spatial trend of change under change analysis 

tab with order of polynomial set as 3rd. 

The present study used 1993 as earlier land cover image and 2005 as later land cover image 

in the Change Analysis tab of LCM. In Transition Potentials tab, four transition sub-models 

were evaluated; water_urban; agriculture_urban; forest & plantation_urban; barren_urban and 

gave six variables as driving variables for the change in urbanization. The transition sub-

model ran using MLP Neural Network with 1500 sample size per class for 10000 iterations. 

MLP (Multi-Layer Perception) neural network has been extensively enhanced to offer an 

automatic mode that requires no user intervention. In addition, it provides valuable 

information about the contributions of explanatory variables. With MLP, multiple transitions 

can be grouped into a single sub-model if it was considered that they all result from the same 

underlying driving forces. Only MLP can be used to model multiple transitions in one sub-

model. 

In this LCM, MLP was operated in automatic mode whereby it makes its own decisions about 

the parameters to be used and how they should be changed to better model the data. 

Automatic mode monitors and modifies the start and end learning rate of a dynamic learning 

procedure. The dynamic learning procedure starts with an initial learning rate and reduces it 

progressively over the iterations until the end learning rate was reached when the maximum 

number of iterations was reached. If significant oscillations in the RMS error were detected 

after the first 100 iterations, the learning rates (start and end) were reduced by half and the 

process has started again. 

Finally, in Change Prediction tab, the year 2050 was selected as prediction date and selected 

Markov Chain as change demand modeling and run the model.  

Post correction was done for the 2050 predicted land use image with reference to the master 

plan designed by the govt. of Andhra Pradesh in ERDAS by assigning high density zones, 

medium to high density zones, govt. zones, educational zones, industrial zones into urban 

class and open & recreation zones into forest and plantation class. Based on the past change 

only, the model will predict the future change but Amaravati is a planned city, post correction 

in accordance with the developed master plan should be done to see the rate of change of 

urbanization. 
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4.4 Comparison Studies of Amaravati with Some Indian Bifurcated State Capitals 

Andhra Pradesh state was bifurcated on 2014 and stated their capital city as Amaravati on 

2015. To see the other Indian bifurcated state capitals water problems and do not want 

Amaravati city to face those things, a comparative study was done by selecting 3 Indian states 

which were bifurcated after the year 2000.  

For this, the population data of selected state capitals was obtained from govt. of India census 

data and population forecasting studies done using Arithmetic Increase Method and 

Geometric Increase Method up to 2050. 

4.4.1 Arithmetic increase method: 

In this method, the average increase in population per decade was calculated from the past 

census reports. This increase was added to the present population to find out the population of 

the next decade.  Thus, it was assumed that the population was increasing at constant rate. 

Hence, dP/dt = C i.e., rate of change of population with respect to time was constant. 

Therefore, population after nth decade will be Pn = P + n.C     (4.1) 

Where, ‘Pn’ is the population after ‘n’ decades and ‘P’ was present population.  

4.4.2 Geometric increase method: 

In this method, the percentage increase in population from decade to decade was assumed to 

remain constant. The population at the end of nth decade ‘Pn’ can be estimated as: 

Pn = P (1+IG/100)n    (4.2)  

Where, IG = Geometric mean (%) 

P = Present population 

n = no. of decades 

 

The existing drinking water sources data of Amaravati were obtained from govt. open data 

source and analyzed the data to depict which source systems were using more by local 

population. 

The past studies on Ranchi were collected based on literature review & govt. data and 

analyzed how growth rate impacted the water resources on the city and suggested some 

recommendations to Amaravati. 
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4.5 Quantification and Estimation of Suggested Water Demand Management Options 

With the suggested water demand management options for the sustainability of Amaravati, 

the amount of water can be saved were quantified based on the recommended percentages 

from the literature review, in view of the planned targeted amount of water supply and 

projected population estimated by govt. of Andhra Pradesh. 

The over all methodology as discussed in the present chapter is presented in Figure 4.2. 

 

 

Figure 4.2 Flow chart of Methodology 

 

 

Analysis of Land Use/Land Cover by 
using ArcGIS and ERDAS

Prediction of Future Land Use/Land Cover 
by using TerrSet with the help of Markov 
Model

Identification of existing water supply 
sources, analysis of Census data

Compare the development trend of Amaravati 
with some bifurcated state capitals of India

Suggest a better sustainable urban water 
management plan
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Chapter 5 

RESULTS AND DISCUSSIONS 

5.1 Past Land Use/Land Cover Analysis 

With ArcGIS and ERDAS, the study analysed the land use/land cover data for the years from 

1993 to 2017 to understand the land use conversion pattern for five land use/land cover types. 

The summary of land conversions has presented from Table 5.1 to 5.4. 

From Table 5.1, the study observed negative percentage of change in water bodies, 

agriculture (very little change) and forest & plantation areas but barren and settlement shows 

some positive percentage of change for the period 1993-1997 (Figure 5.1 and 5.2). 

Table 5.2 shows that the area of water bodies was drastically decreased and the remaining 

land cover areas showed positive change in which barren land showed greater percentage of 

change for the period 1997-2005 (Figure 5.2 and 5.3). Since river water was decreased and 

those areas were converted into barren, that’s why the conversion change results showed the 

increase of barren land area. During this time period, the river faced some drought conditions 

and when cross checked with CWC Data (Figure 5.4), the results showed the decrease of 

water availability in river Krishna at the gauge station, Prakasam Barrage, Vijayawada, which 

was located besides the capital city. 

Table 5.3 shows greater percentage of positive change in areas of water bodies and settlement 

but negative percentage of change in agriculture, forest & plantation and barren land areas for 

the period 2005-2011 (Figure 5.3 and 5.5). Greater percentage of water area change clearly 

reflects the high negative percentage of barren land change. There is significant increase in 

settlement area in this time period clearly understood that small developments had been 

started from this time period in the study area. 

From Table 5.4, the study reveals that areas of settlement, agriculture and barren land 

substantially changed during the period 2011 – 2017 (Figure 5.5 and 5.6). After the capital 

city announced on 2015, the government started converting the agricultural land into flat and 

barren to start the constructional activities according to the master plan they developed. 

That’s why; there is a drastic change from agricultural land to barren land. (The study 

considered 2017 was the intermediate stage of land cover change and took it as temporary 

change, so the flat converted agricultural land was termed as barren land cover). 
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Note: From Table 5.1 to 5.4, figures in the rows and columns represent area of each land type 

changed to others during the respective years. The bolded figures represent the area of land 

remained unchanged during the respective years. Figures in the last column represent the 

percentage of land use decrease or increase. It is calculated by dividing the difference of 

respective land use/cover and multiplied by 100. 

Table 5.1 Area (km2) of each land type changed to others during the year 1993-1997 

Land type Water Settlement Agr. 
Forest & 

Plantation 
Barren 

Total 

(1997) 

Change 

(%) 

Water 11.17 0.04 0.73 0.58 0.41 12.94 -2.67 

Settlement 0.02 0.90 3.69 0.35 0.10 5.07 2.38 

Agr. 0.45 3.57 165.54 2.54 0.44 172.54 -0.45 

Forest & 

Plantation 
0.43 0.30 2.79 10.54 0.07 14.13 -1.36 

Barren 1.22 0.14 0.57 0.31 11.89 14.13 9.45 

Total 

(1993) 
13.30 4.95 173.33 14.32 12.91 218.81 --- 

 

 

Figure 5.1 Land use/Land cover map of Amaravati in 1993 
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Figure 5.2 Land use/Land cover map of Amaravati in 1997 

 

 

Table 5.2 Area (km2) of each land type changed to others during the year 1997-2005 

Land type Water Settlement Agr. 
Forest & 

Plantation 
Barren 

Total 

(2005) 

Change 

(%) 

Water 6.97 0.01 0.74 0.26 0.48 8.47 -34.59 

Settlement 0.14 1.18 3.20 0.51 0.13 5.17 1.95 

Agr. 0.82 3.65 165.63 3.15 1.25 174.50 1.14 

Forest & 

Plantation 
2.65 0.19 2.49 9.50 0.11 14.93 5.70 

Barren 2.37 0.03 0.48 0.70 12.15 15.74 11.38 

Total 

(1997) 
12.94 5.07 172.54 14.13 14.13 218.81 --- 
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Figure 5.3 Land use/Land cover map of Amaravati in 2005 

 

 

 

 

Figure 5.4 Some Indian rivers water availability at different gauge stations (CWC Data) 
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Table 5.3 Area (km2) of each land type changed to others during the year 2005-2011 

Land type Water Settlement Agr. 
Forest & 

Plantation 
Barren 

Total 

(2011) 

Change 

(%) 

Water 7.34 0.23 1.40 2.20 2.96 14.13 66.93 

Settlement 0.02 1.75 6.11 0.42 0.21 8.51 64.65 

Agr. 0.65 2.77 163.21 2.43 0.77 169.82 -2.68 

Forest & 

Plantation 
0.13 0.36 3.12 9.36 0.10 13.07 -12.50 

Barren 0.32 0.06 0.67 0.53 11.70 13.28 -15.61 

Total 

(2005) 
8.47 5.17 174.50 14.93 15.74 218.81 --- 

 

 

 

Figure 5.5 Land use/Land cover map of Amaravati in 2011 
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Table 5.4 Area (km2) of each land type changed to others during the year 2011-2017 

Land type Water Settlement Agr. 
Forest & 

Plantation 
Barren 

Total 

(2017) 

Change 

(%) 

Water 11.40 0.01 0.62 0.21 0.48 12.72 -9.99 

Settlement 0.14 3.81 8.64 0.34 0.10 13.04 53.27 

Agr. 0.44 1.83 39.07 1.40 0.48 43.23 -74.54 

Forest & 

Plantation 
1.07 0.30 5.41 9.38 1.63 17.80 36.21 

Barren 1.08 2.55 116.08 1.73 10.59 132.02 893.96 

Total 

(2011) 
14.13 8.51 169.82 13.07 13.28 218.81 --- 

 

 

 

Figure 5.6 Land use/Land cover map of Amaravati in 2017 
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Table 5.5 shows the land conversion of Amaravati from 1993-2017. There was great 

percentage of settlement change and less negative percentage change of water bodies which 

shows that water bodies areas were stressed in the recent years. There was good percentage of 

forest & plantation area change shows that the people and govt. was concentrated more on 

greenery in the recent years. The reason for the greater percentage of areal change in 

agriculture and barren was explained earlier as 2017 was considered as temporary change 

since the flat converted agricultural land was termed as barren land cover. 

 

Table 5.5 Area (km2) of each land type changed to others during the year 1993-2017 

Land type Water Settlement Agr. 
Forest & 

Plantation 
Barren 

Total 

(2017) 

Change 

(%) 

Water 9.11 0.03 1.05 1.26 1.26 12.72 -4.34 

Settlement 0.06 1.21 10.77 0.73 0.27 13.04 163.41 

Agr. 0.29 1.63 39.53 1.20 0.57 43.23 -75.06 

Forest & 

Plantation 
1.92 0.33 5.27 9.47 0.81 17.80 24.26 

Barren 1.92 1.74 116.70 1.66 10.00 132.02 922.57 

Total 

(1993) 
13.30 4.95 173.33 14.32 12.91 218.81 --- 

 

 

The different land cover classes contributions to settlement for the different time periods have 

been shown in from Figure 5.7 to 5.11.  

Figures 5.7 to 5.11 show that more agricultural land area was contributed to settlement with 

very less water bodies area contribution. Higher agricultural land contribution to settlement 

was observed during 2011 to 2017 and least contribution during 1997 to 2005. There was 

significant contribution from forest & plantation area to settlement also, higher areal 

conversion during 1997 to 2005 and least conversion during 2011 to 2017. 

Note: The settlement area from Figures 5.7 to 5.11 were the unchanged area during the 

respective time period of land use change.  
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Figure 5.7 Areal contribution of all land cover classes to settlement during 1993 to 1997 

 

 

 

Figure 5.8 Areal contribution of all land cover classes to settlement during 1997 to 2005 
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Figure 5.9 Areal contribution of all land cover classes to settlement during 2005 to 2011 

 

 

 

Figure 5.10 Areal contribution of all land cover classes to settlement during 2011 to 2017 
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Figure 5.11 Areal contribution of all land cover classes to settlement during 1993 to 2017 

 

5.1.1 Land use/land cover overall change analysis 

The maps of land use/land cover for the study area have already been presented in the 

previous section (Figure 5.1 to 5.3; Figure 5.5 and 5.6).  

The consolidated output of different classes of land use/land cover was presented in Table 5.6 

and the variation of different classes has shown in Figure 5.12. 

The results showed that settlement substantially increased from the year 2005. From 2011 to 

2017, most of the agricultural land is converted to barren land due to selection of that area as 

capital city and started to prepare the land for construction by making flat and barren.  

The land use/cover results showed the urban area change from 1993-2017 is 8.09 km2, which 

is 3.7% for 24 years. So, urban area is growing at a rate of 0.33 km2/year. Since, most of the 

area was covered in agricultural fields; the rate of urbanization was very low during 1993-

2017.  
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Table 5.6 Area (km2) of each land type for different years 

Area (km2) 1993 1997 2005 2011 2017 

Water 13.30 12.94 8.47 14.13 12.72 

Urban 4.95 5.07 5.17 8.51 13.04 

Agriculture 173.33 172.54 174.50 169.82 43.23 

Forest & 

Plantation 
14.32 14.13 14.93 13.07 17.80 

Barren 12.91 14.13 15.74 13.28 132.02 

 

 

 

Figure 5.12 Change in area of five land cover types during the period of 1993-2017 

 

5.2 Future Land Use Prediction 

In the present study, future land use was predicted for the year 2050. For this purpose, the 

following are the input file maps for the TerrSet Model: 

(a) DEM map 

(b) Slope map 
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(c) Distance_road map 

(d) Distance_urban map 

(e) Cubic trend map of transition from all to urban 

The input files prepared for the study area are presented in from Figure 5.14 to 5.17. 

Figure 5.14 showed that almost all the area comes under the first category; 4-21m elevation. 

This depicts that the capital city area was almost flat surface, so that chances are more for 

urban flooding due to storm water. The values in the Figure 5.13 were represented in meters. 

Figure 5.15 represents the slope map of the study area and complete area lies under the first 

category; 0-3.62 degrees.  

Figures 5.16 and 5.17 show the distance map from roads and urban areas respectively, 

contains the measured distance from each cell to the nearest source, i.e. roads and urban 

areas. 

Conceptually, the Euclidean algorithm works like that for each cell, the distance to each 

source cell is determined by finding the hypotenuse with x_max and y_max as the other two 

legs of the triangle (Figure 5.13). This calculation derives the true Euclidean distance, rather 

than the cell distance. 

 

Figure 5.13 Determining true Euclidean distance 

 

The areas having highest Euclidean distance value means that they were very far from the 

road network/urban areas. Figure 5.16 shows less percentage area lies in farthest from road 

networks. Figure 5.17 shows the significant amount of area lies in farthest from urban 

centres. 
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Figure 5.14 Digital Elevation Model of the study area 

 

 

 

Figure 5.15 Slope Map of the study area 
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Figure 5.16 Distance_Road Map of the study area 

 

 

 

Figure 5.17 Distance_Urban Map of the study area 
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Figure 5.18 shows the cubic spatial trend map of transition from all land use classes to urban 

class. The intention of the spatial trend of change map is to provide the means of generalizing 

the pattern of change. The numeric values do not have any significance, rather than to 

provide an indication of more intense change (higher numbers, redder colours) or less intense 

change (lower numbers, darken green to blue colours). The output was a smooth surface 

which represents the gradual trends in the transition in land cover over all classes to urban 

class. This was the best fit polynomial trend surface to the pattern of change. The results 

showed that the right-side bottom and middle corner parts of the study area showed more 

prone to transitions. 

 

 

Figure 5.18 Cubic spatial trend map of transition from All to Urban 

 

The results of predicted future land use/cover conversions are presented in Table 5.7. The 

results showed urban area change (land loss due to urban growth) from 2017 to 2050 is 58.63 

km2, which is 26.95% for 33 years. So, urban area is increasing at a rate of 1.77 km2 per year. 

The urbanization rate is going to increase in future after developed as smart capital city and 

this much urbanization was not observed in past. During 1993-2050, the agriculture land was 

reduced by 72.59 km2 area with the loss of 41.88%. 
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Urban development is the significant customer of land. In the U.S., it is evaluated that 100 m2 

of land for each sec is lost to urban use; Germany loses around 14 m2 for every sec and 

Switzerland loses around 1 m2 for each sec. By watching the inclination of land loss of Indian 

urban areas or real capital regions because of urban development, the information 

demonstrates that around 60.57 km2 of land for each year was lost to urban use in New Delhi 

Region and its surroundings (National Capital Region), whereas Ahmadabad, Lucknow and 

Ranchi urban areas were losing 11.12 km2 every year, 8.25 km2 every year and 2.24 km2 

region for each year individually, which are generally high when contrasted with Amaravati 

capital city. The predicted land use/land cover map for the year 2050 is presented in Figure 

5.19. 

These past and future land use/cover studies are very useful for impact analysis on surface 

and ground water availability which in turn affects the water supply demand for the 

population. With these, the planner should develop water management plans in a sustainable 

manner in view of future population demand and supply analysis. 

Table 5.7 Area (km2) of each land type for the year 2050 

Land use Class 

2050 

Area (km2) 

Water 7.90 

Settlement 71.67 

Agriculture 100.74 

Forest & 

Plantation 
23.07 

Barren 15.40 

 

 

Figure 5.19 clearly showed how much urbanization is going to happen in 2050. The right-side 

portion of the city (Mangalagiri municipality area) is going to be more urbanized. Secondly, 

the govt. is going to create more open and recreation places in and around the city for tourism 

purpose and these can be used for storm water management practices to reduce the impact of 

urban flooding on the city and can create more ground water recharge sites. 
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Figure 5.19 Predicted Land use/Land cover map of Amaravati in 2050 

 

5.3 Comparison of Amaravati with Some Indian Bifurcated State Capitals 

In the present study, it was considered to study the growth pattern of bifurcated state capitals. 

Thus, four states formed in past were considered, the details are given in Table 5.8. 

Table 5.8 shows the state names, date of bifurcation along with capitals which compared with 

Amaravati capital city. 

Table 5.8 Comparison states, their capitals and bifurcation date 

State  
Bifurcation 

Date 
Capital 

Uttarakhand 09-Nov-00 Dehradun 

Chhattisgarh 01-Nov-00 Raipur 

Jharkhand 15-Nov-00 Ranchi 

Andhra Pradesh 02-Jun-14 Amaravati 
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5.3.1 Census data for 2001 and 2011 

The census data of the four states for the years 2001 and 2011 are given in Table 5.9. 

The data clearly depicts that percentage of change was more in view of Metropolitan 

outgrowth of cities. Raipur and Ranchi show more percentage of change compared to 

Dehradun which was hilly terrain city. The study reveals that Ranchi city's development as a 

modern urban focus started in the 1980s. According to the evaluation in 2011, its populace 

has developed at around 4.38% every year, higher than the national normal of 2% and this 

has put enormous pressure on the city's water assets. 

Many studies conducted on urban growth of Ranchi and one study revealed that built-up 

growth of 473.7% amid 1927-2005 was basically to the detriment of agrarian land alongside 

the diminishment of normal water bodies reflects negative effects of developed extension. 

So, the planner should also consider these aspects at the planning stage of cities, as the cities 

will grow faster when declared as metropolitan or smart cities.  

Table 5.9 Census data for 2001 and 2011 of comparison cities and % of changes 

City Name 2001 2011 

Non- 

Metropolitan 

(2011) 

% Change % Change 

(Metropolitan 
(Non-

Metropolitan 

Consideration) Consideration) 

Dehradun 4,26,674 5,74,840 5,69,578 34.73 33.49 

Raipur 6,05,747 11,23,558 10,27,264 85.48 69.59 

Ranchi 8,47,093 11,26,720 10,73,427 33.01 26.72 

Amaravati 72,642 1,14,974 ---  ---  58.27 

 

5.3.2 Population forecasting data 

The water supply designs were based on the projected population of the city, estimated for 

the design period. Any underestimated or overestimated value will create lot of problems and 

will not serve the purpose intended. The population was predicted using various methods 

which was suitable for the city with the consideration of the growth pattern followed by the 

city. 
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The present study used Arithmetical Increase Method and Geometrical Increase Method for 

the population prediction.  

Arithmetical increase method was suitable for large and old city with considerable 

development and if it was used for small, average or comparatively new cities, it will give 

lower population estimations than actual values. The results of Arithmetic increase method of 

population forecasting are presented in Table 5.10. 

Geometrical increase method gives higher values when compared to the previous method and 

can be applied for a new city at the beginning of development for only few decades. The 

results of Geometric increase method of population forecasting are presented in Table 5.11. 

The results of both methods are represented in graphical forms and shown in Figures 5.20 to 

5.23.  

The master plan of Amaravati estimated 35.5 lakh population but as per Geometric increase 

method, it came around 7.2 lakh population. Since, it was a planned city; more settlers will 

come and settle in the city and expected more population in future. If we closely observe the 

data and the estimated population of Amaravati in 2050, Amaravati capital city estimated 

population was approximately matching the Ranchi city projected population.  

The growth rates of Ranchi and Amaravari were not same but still the comparison was 

carried to look the problems associated with water sector of Ranchi and can recommend some 

suggestions inorder to make Amaravati, a future sustainable city and see that city should not 

face those kind of problems. 

Table 5.10 Arithmetic Increase Method of population forecasting 

City Name 2001 2011 2021 2031 2041 2051 

Dehradun 4,26,674 5,74,840 7,23,006 8,71,172 10,19,338 11,67,504 

Raipur 6,05,747 11,23,558 16,41,369 21,59,180 26,76,991 31,94,802 

Ranchi 8,47,093 11,26,720 14,06,347 16,85,974 19,65,601 22,45,228 

Amaravati 72,642 1,14,974 1,57,306 1,99,638 2,41,970 2,84,302 
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Table 5.11 Geometric Increase Method of population forecasting 

City Name 2001 2011 2021 2031 2041 2051 

Dehradun 4,26,674 5,74,840 7,74,458 10,43,395 14,05,722 18,93,870 

Raipur 6,05,747 11,23,558 20,84,010 38,65,485 71,69,819 1,32,98,798 

Ranchi 8,47,093 11,26,720 14,98,652 19,93,360 26,51,372 35,26,595 

Amaravati 72,642 1,14,974 1,81,975 2,88,020 4,55,864 7,21,518 

 

 

Figure 5.20 Forecasted population of Dehradun 

 

 

Figure 5.21 Forecasted population of Raipur 
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Figure 5.22 Forecasted population of Ranchi 

 

 

Figure 5.23 Forecasted population of Amaravati 

 

5.3.3 Existing drinking water sources status of Amaravati 

Coming to present drinking water status of Amaravati capital city villages, Annexure-I shows 

the main source of drinking water status (as per 2011 data) of 3 main sub-districts, namely 

Thullur; Tadepalle and Mangalagiri, which took a major part of area in Amaravati. 
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The data depicts that they are mainly depend upon river Krishna water and secondly most on 

ground water through hand pumps, tube wells, etc. So, river Krishna water availability is 

utmost importance for water sustainability of city. And also, from the collected data and 

interaction with govt. and local bodies, ground water is available at reasonable depths and 

there will be no problem of ground water availability for the study area. 

5.3.4 Comparison study – Ranchi and Amaravati 

Owing to unexpected out growth of Ranchi city, meeting the urban water demand has 

become a major problem and expecially in summer as some densely populated areas in the 

city were used to declared as dry zones because of acute water shortage (Figure 5.24). Ranchi 

has difficulty in ground water retention, has limited ground water, considering its granitic 

rock system, which has poor water-retention capacity. The residents were relying upon water 

provided by municipal corporation for drinking and also residential use yet in summers, extra 

water tankers were conveyed and water apportioning was done. 

 

Figure 5.24 Harmu, a dirty waterway winds through the city centre 

As per the report of the India Smart Cities Challenge, a competition for municiapal bodies in 

India, Ranchi meets the 135 lpcd water supply benchmark. However, the non-revenue water 

in the city is very high at 70%. 83% of the streets have a water distribution network and 48% 
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households have water connections. The drinking water and sanitation department, supplies 

water to 70% of its population. Improper sewerage or a storm water drainage system results 

in waterlogging during monsoon periods. The 4 rivers which were passing through Ranchi 

have been modified into drains due to high pollutant discharge (Figure 5.25). Clearly, there is 

lack of coordination between various agencies make city water crisis. 

 

Figure 5.25 The city's water bodies like Arghoda talab were dirty, clogged with plastic, 

garbage and sewage 

 

5.3.4.1 Lessons from Ranchi – recommendations for Amaravati 

Observing Ranchi’s outgrowth impact on water resources, the following suggestions 

recommended for Amaravati city: 

 Urban development without following advancement design/master plan may prompt 

serious urban issue like surface and sub-surface water shortage, solid waste disposal 

issue, air and water contamination, urban cleanliness etc. Amaravati was developing 
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based on the prepared master plan so the past and future land use/ land cover analysis 

studied in the present research will help to check the urbanization rate and impact 

studies can be conducted by the planners for better management. 

 The monitoring of ground water usage and recharge-depletion studies should be 

conducted every year for better control over the sub-surface water resources. 

 Systematization of the water supply system by sectorization of the system for better 

monitoring of the system to have control over non-revenue water. 

 A separate body should be formed to look over the Industrial waste discharges into 

the drains to maintain the healthiness of the river. 

 The suggested Theme city level strategic planning will have better coordination 

between various agencies to look over the drinking water issues and storm water 

discharges. 

 Like Ranchi, the city’s water connection application and water tax deposit should 

made online to improve the collection efficiency (Ranchi’s efficiency increased up to 

30%) of the water supply-related charges. With that revenue generated, more water 

supply coverage can made and management costs can take care off for better water 

supply networks. 

5.4 Urban Water Resources Management Plan 

In order to meet the future water demands of population, one should not go for more supply 

side management options by searching for more sources of supply as they degrade the 

environment. Instead of this, one should adopt better demand side management options for 

better management of water resources by increasing the efficient use of water, water reuse 

and utilizing the rainfall in a better and useful manner for good health of future smart cities. 

One of the approach suggesting for Amaravati capital city for better water resources 

management is SWITCH Approach – Sustainable Water Management Improves 

Tomorrow’s Cities’ Health. (www.switchurbanwater.eu) 

SWITCH approach was successfully implemented in many cities like Accra, Alexandria, 

Beijing, Birmingham, Hamburg, Lima, Zaragoza, etc. and the complete list with respective 

water issues solved are presented in Table 5.12. 

 

http://www.switchurbanwater.eu/
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Table 5.12 SWITCH approach implemented in different cities of world 

 

(www.switchurbanwater.eu/cities/index.php) 

 

S. 

No 
City 

Average  

annual  

rainfall 

(mm) 

Priority water issues 

1 Lima, Peru 13 

Impacts of climate change on Andean water sources; 

Water supply for greening and productive activities  

in a context of extreme scarcity 

 

2 
Alexandria, 

Egypt 
178 

Managing water supply (from Nile) and demands; 

flooding risks; managing industrial discharges to 

reduce pollution 

 

3 
Zaragoza, 

Spain 
318 

Water demand management; using water to improve 

the urban environment 

4 Tel Aviv, Israel 531 
Managing water supply and demands in context of  

scarcity, recycling and reuse of waste water 

5 Beijing, China 572 Water scarcity due to high and growing demands 

6 Lodz, Poland 599 
Restoration of polluted and buried rivers as part of  

revitalization efforts; flash flooding 

7 
Birmingham, 

UK 
662 

Future risks; climate change, rising groundwater  

levels, flooding 

8 Accra, Ghana 725 
Access to water and sanitation services especially in  

low-income neighbourhoods 

9 
Hamburg, 

Germany 
773 

Redevelopment of waterfront locations; flood 

protection 

10 
Bagota, 

Colombia 
824 

Industrial and waste water pollution of Rio Bagota  

and impacts on the environment and city water supply 

11 Cali, Colombia 908 
River pollution, an integrator of different problems 

upstream, and its impacts 

12 
Belo Horizonte, 

Brazil 
1491 

Preventing flooding, collection and treatment of waste 

water 

 

http://www.switchurbanwater.eu/cities/index.php


45 

 

The main key features of SWITCH Approach included: 

a) Learning Alliances: Advancement of partner stages, called Learning Alliances, to guide 

and bolster the usage of research and showing exercises in the city. They spoke to some 

useful methods for bringing key partners (individuals and associations) into a gathering 

where they could talk about issues, screen and assess the procedure of change and think of 

solutions. 

b) City-Level Strategic Planning: This procedure included visioning, situation 

distinguishing proof and improvement of vital headings or systems. Three essential models 

(CITY WATER Balance, CITY WATER Drain, and CITY WATER Economics) should 

create to enable the city to investigate the natural, monetary and physical ramifications of 

water management options.  

One need to understand the problems of other cities facing on water and failed in execution of 

water management options. The lessons should understand like large number of organizations 

involved in the urban water sector leading to ambiguity in responsibilities, lack of expertise 

in IUWM in planning organizations, difficulty in agreeing on indicators for IUWM rather 

than collection of indicators and mostly the short-to medium-term focus of water 

management organizations which made it difficult to plan for a 30-50-year timescale. 

Based on all these outcomes, the study suggested Theme City Level Strategic Planning as the 

master plan of Amaravati included 9 theme cities. The organizations of each theme city 

should look out the theme city water balance and problems and should solve at theme level 

itself and there should be a one central level organization to look after all these 9 

organizations. If there are any inter-theme city problems, those two theme city organizations 

should come up with single solution and should solve it. By doing this, there will be a better 

water management at regional and local level. 

Urban Water Management Plan recommended for Amaravati capital city: 

a) Water security through RE-USE: 

 Soil Aquifer Treatment (SAT) 

 Engineered Environmental Buffer Technologies 

 Aquifer Storage & Recovery 

These three were useful for increasing water reuse efficiencies and able to increase the 

recharge of ground water. 
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b) Water demand management options: 

 Management of water loss by installing District Meter Areas (DMAs) with flows and 

pressures monitored, linked to a GIS & Simulation Model. 

 Water harvesting potential of city by rain water harvesting at roof top of buildings. 

 Grey water (waste water) generated from bathing, hand and face washing and clothes 

washing should be recycled and reuse for flushing of toilets and gardening to reduce 

some water demand. 

 Water metering is an important tool for reduction of water demand; in addition, 

metering also ensures detection of leakage in the system. The literature indicated that 

installation of water meters typically reduced consumption in the range of 10 to 30% 

and sometimes as high as 50%. For Indian group housing, the saving due to metering 

is considered on an average of 20% and this should be adapted to Amaravati city 

houses. 

 Water saving devices like water saving cisterns, water saving shower or low flow 

shower, dual flush water system, water saving taps greatly save the water and reduce 

the house hold water demand. 

c) Water sensitive urban design: 

 River Krishna restoration using the principle of eco-hydrology to manage storm 

water, increase water retentiveness & improve water quality & overall improve the 

quality of life for residents by installation of on-line hydrological & meteorological 

monitoring systems, construction of sedimentation basins & specially designed 

reservoirs & planting of vegetation as the city is primarily depends on river Krishna 

water for drinking purposes. 

d) Low impact development/Green infrastructure: Low impact development limits the 

ecological effect of advancement by overseeing storm water near its source, copying common 

frameworks that would permit storm water to invade into the ground, or giving transitory 

stockpiling so its discharge into the storm water system is moderated. 

The eight Green programs recommended for Amaravati city are Green Streets, Green 

Schools, Green Public facilities, Green Parking, Green Parks, Green Industry, Business, 

Commerce and Institutions, Green alleys, driveways and walkways and Green Homes. 

Green Roof Buildings and Brown Roof Buildings are likewise extremely helpful in 

diminishing storm water overflow intensity by postponing, holding and returning water to the 
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air by means of ET and in this way lessen weight on the urban seepage framework, decrease 

the occurrences of urban flooding, there by having impressive potential for usage inside 

sustainable (urban) drainage systems. 

The different low impact development practices which can be implemented in the city are 

represented in the Figure 5.26. 

The importance of Low Impact Development/Green Infrastructure on storm water were stated 

as follows: 

 By adopting Permeable Pavements, 22% of runoff leaves the system during a storm 

 With Green Roofs, 60-70% of storm water volume can be reduced 

 With Bioretention facilities, 26-52% of runoff retention can be achieved 

 

 

Figure 5.26 Different Low Impact Development practices 
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5.4.1 Quantification and estimation of suggested water demand management options: 

The govt. of Andhra Pradesh planned to supply 150 lpcd for the domestic water supply with 

100% metering target. The estimated 2050 residential population of Amaravati is 35,52,950.  

The govt. is planning to construct 2 extra sources of supply for Amaravati and one diversion 

canal (Pattiseema lift scheme to interlink River Godavari and River Krishna) was completed 

and they estimated the availability of water at source level for 2050 and the data is 

represented in the Table 5.13. 

Table 5.13 Existed and Proposed sources of supply for Amaravati 

S. No Source Name 
Existed/ 

Proposed 

Storage (2050) 

TMC 

Storage (2050) 

MLD 

1 Prakasam Barrage Existed 3.07 86.91 

2 Neerukonda Reservoir Proposed 0.41 11.61 

3 Vaikuntapuram Barrage Proposed 6.00 169.86 

4 
Polavaram RMC 

Diversion 
Completed 84.70 2,397.86 

 

 

The estimated residential demand at end user level was 532.94 MLD and considered 

unaccounted water of 10%, so total residential water demand at source level was 586.24 

MLD. 

The study considered all types of water uses in residential buildings (Table 5.14) and bathing, 

hand/face wash and cloth wash were considered for grey water generation and an average of 

70% was considered for grey water reuse. This re-usable grey water was recommended to use 

for toilet flush and gardening purposes and places where less contact with persons. 

Through water metering, an average of 20% of water (recommendation from literature 

review) can be saved, which means 30 lpcd (106 MLD) and it accounts 19.8% of total 

demand. 

The study considers the average flushing of toilet was 5.7 times per day because the 

estimated use was 57 lpcd and average cistern capacity of 10 liters. The estimated water if 

dual flushing (6/3) was adopted in place of single flush was approximately 23.1 lpcd (2X6 + 

3.7X3) which means a total of 33.9 lpcd (59.4% of flush demand) can be saved. 
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From Table 5.14, a total of 38.42% of water can be saved with the suggested demand side 

management options. The result shows that the sum of 57.63 lpcd (204.75 MLD) can be 

saved at domestic level. It means a total of 225.23 MLD can be saved at water source level 

(unaccounted water of 10%). 

Table 5.14 Different residential water uses and water saving calculations for Amaravati 

S. No 
Residential 

water use 

Water 

use 

(%) 

Estimated use 

(lpcd) 

Saving with 

water saving 

measures (%) 

Estimated 

water 

requirements 

(lpcd) 

1 Drinking 3 4.5 --- 4.5 

2 Cooking 2 3 --- 3 

3 Bathing 25 37.5 30 26.25 

4 Utensil wash 5 7.5 50 3.75 

5 
Hand and face 

wash 
3 4.5 50 2.25 

6 Cloth wash 15 22.5 30 15.75 

7 Floor wash 6 9 --- 9 

8 Toilet flush 38 57 59 23.37 

9 Gardening 1 1.5 --- 1.5 

10 Car wash 2 3 --- 3 

 Total 100 150  

92.37 

(38.42% 

saving) 

 

 

The study also estimated the percentage of population adopted the demand side management 

options and amount of water can be saved and it is presented in Table 5.15. 

The two proposed sources storage was 181.47 MLD at source level for 2050 (Table 5.13) and 

Table 5.15 clearly shows that if 100% (38.42% saving) and 90% population (34.57% saving) 

adopted the recommended practices, they can save more than the two-proposed storage water. 

If 80% (30.73% saving) population adopted the demand management options, the proposed 

Vaikuntapuram barrage source can be avoided. At least Neerukonda reservoir can be avoided 
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if at least 50% population (19.20% saving) can adopt the demand side management practices. 

The construction and maintenance costs of these two sources can be saved and utilized for the 

better management of these practices and govt. may also give subsidies, recommending using 

water saving devices, dual flush systems and installation of grey water recycle plants at 

colony levels for better sustainability of Amaravati. 

Table 5.15 Water saving calculations for % of population adopted the recommended WDM 

options 

S. No % of Population adopted 
Water Saved at 

end user (MLD) 

Water Saved at 

source level (MLD) 

1 100 204.75 225.23 

2 90 184.27 202.70 

3 80 163.80 180.18 

4 70 143.32 157.65 

5 60 122.85 135.13 

6 50 102.37 112.61 
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Chapter 6 

CONCLUSIONS 

 

6.1 General 

Studies on land use/cover are crucial for supporting land use management decisions. Past 

land use/cover analysis shows very low increase on urban rate whereas future land use/cover 

prediction suggests that rapid increase on urbanization due to declaration of capital city and 

its growth also depends on smart city development. With these past and future land use/cover 

data, impact studies can be conducted on surface and ground water resources which will 

useful for water balance studies of the study area. 

Comparing capital city with other bifurcated state capitals is very useful to understand the 

water scarcity and management problems faced by the cities with the unexpected outgrowth 

of population and urbanization. Ranchi city forecasted population matches with the estimated 

master plan population of Amaravati which significantly can study the changing patterns of 

both cities with respect of water balance and water resources management. 

SWITCH approach helps to make the city more sustainable in future with learning alliances, 

theme-city level strategic planning studying theme level city water balance, water drain and 

water economics. The suggested urban water resources management plan could help the city 

for not running towards more sources and can eliminate the construction of two proposed 

storage supplies and with the saved amount, the govt. can give subsidies to implement these 

saving devices at higher percentages in buildings. 

The city can reduce the water demands with the proposed management options by increasing 

water reuse efficiencies with SATs, aquifer storage & recovery, engineered buffered 

technologies; implementing water demand management options like installing DMAs, 

systemization of water supply system, water metering, water saving devices, rain water 

harvesting at roof tops, green and brown buildings, constructing green infrastructure, grey 

water reuse; water sensitive urban design through river Krishna restoration using eco-

hydrology principles, etc.  
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6.2 Conclusions 

From the present study, the following conclusions were obtained: 

i. The past land use/land cover analysis showed the urban area change from 1993 to 2017 

was 8.09 km2, at a slow growing rate of 0.33 km2/year. This was very low urban change 

since most of the area were covered by agricultural lands and the population was totally 

depend on the agriculture as the land was very fertile due to the river fed land. 

ii. The predicted future land use change showed the urban change from 2017 to 2050 was 

58.63 km2, increased at a rate of 1.77 km2/year. This land loss due to urban growth was 

very less compared to some Indian cities like Delhi, Ahmadabad, Lucknow, Ranchi, 

etc.  

iii. Monitoring of ground water usage and recharge-depletion studies; systematization of 

water supply system to have better control over non-revenue water; separate body to 

look over draining of industrial waste discharges in to the river to maintain its health 

and maintenance of online portal for water connection application and water tax deposit 

to improve the collection efficiency were the recommendations suggested for 

Amaravati based on the problems faced by the Ranchi water sector after bifurcation. 

iv. With the suggested water demand options and quantification studies conducted, 

minimum of one and maximum of two water supply sources can be eliminated and with 

that costs of project, the study recommending to give more subsidies to the residential 

households for the maximum implementation of the water saving devices to save more 

water and make city sustainable in future. 

6.3 Future Scope of Work 

i. The impact studies of past and future land use/land cover on water flows using eco-

hydrological model SWAT gives great scope of understanding on water flows and how 

the future urbanization effects the extreme flows in the planned city. 

ii. The impact of future climate change on water resources gives the effect of climate on 

precipitation and temperature so that better management practices can be adopted for 

sustainable drinking water purposes. 
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iii. The combined impact of land use/land cover and climate change on water resources 

gives great idea on which parameters influences more to drive the maximum change on 

the water availability. 

iv. From DEM analysis, the study area lies in almost flat surface. So, developing 3D DEM 

model and identifying critical flooded zones thereby studying storm water effects will 

be very useful for the govt. for selective planning of development at these zones.  

v. The cost and benefit analysis of the recommended water demand management options 

and calculations of water savings for combined implementation of different 

management options will be an added advantage for better planning. 
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ANNEXURE – I 
 

Area 

Name 

Total/ 

Rural/ 

Urban 

Locatio

n of 

source 

of 

drinkin

g water 

Total 

Number of 

Household

s 

Main Source of Drinking Water 

Tap 

water 

from 

treated 

source 

Tap 

water 

from 

un-

treated 

source 

Covere

d well 

Un-

covere

d well 

Hand 

pump 

Tube well/ 

Borehole 

Sprin

g 

River

/ 

Canal 

Tank

/ 

Pond

/ 

Lake 

 Other 

source

s 

Thullur Rural Total 15,731 9,790 1,598 44 26 3,213 168 11 1 729 151 

Thullur Rural 

Within 

the 

premises 

8,496 5,442 948 19 7 1,989 91 - - - - 

Thullur Rural 
Near the 

premises 
4,078 2,678 327 17 12 811 39 10 - 161 23 

Thullur Rural Away 3,157 1,670 323 8 7 413 38 1 1 568 128 

Tadepalle Total Total 26,322 16,548 2,806 43 82 5,310 1,150 3 5 2 373 

Tadepalle Total 

Within 

the 

premises 

15,399 8,688 1,339 33 25 4,285 1,029 - - - - 

Tadepalle Total 
Near the 

premises 
7,949 5,983 1,002 4 40 774 54 3 2 1 86 

Tadepalle Total Away 2,974 1,877 465 6 17 251 67 - 3 1 287 

Tadepalle Rural Total 8,032 3,735 1,107 20 68 2,881 154 1 1 1 64 
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Tadepalle Rural 

Within 

the 

premises 

5,584 2,582 459 18 13 2,383 129 - - - - 

Tadepalle Rural 
Near the 

premises 
1,727 798 456 - 38 398 20 1 1 1 14 

Tadepalle Rural Away 721 355 192 2 17 100 5 - - - 50 

Tadepalle Urban Total 18,290 12,813 1,699 23 14 2,429 996 2 4 1 309 

Tadepalle Urban 

Within 

the 

premises 

9,815 6,106 880 15 12 1,902 900 - - - - 

Tadepalle Urban 
Near the 

premises 
6,222 5,185 546 4 2 376 34 2 1 - 72 

Tadepalle Urban Away 2,253 1,522 273 4 - 151 62 - 3 1 237 

Tadepalle 

(M + OG) 
Urban Total 16,794 11,924 1,172 21 13 2,381 968 2 4 1 308 

Tadepalle 

(M + OG) 
Urban 

Within 

the 

premises 

8,859 5,640 442 13 11 1,863 890 - - - - 

Tadepalle 

(M + OG) 
Urban 

Near the 

premises 
5,739 4,803 457 4 2 367 32 2 1 - 71 

Tadepalle 

(M + OG) 
Urban Away 2,196 1,481 273 4 - 151 46 - 3 1 237 

Mangalagiri Total Total 41,408 28,488 2,665 121 798 8,324 655 7 12 11 327 

Mangalagiri Total Within 

the 
24,373 18,000 1,404 39 264 4,142 524 - - - - 
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premises 

Mangalagiri Total 
Near the 

premises 
10,620 6,972 881 21 346 2,227 97 3 4 5 64 

Mangalagiri Total Away 6,415 3,516 380 61 188 1,955 34 4 8 6 263 

Mangalagiri Rural Total 14,137 5,964 690 34 585 6,377 186 2 11 8 280 

Mangalagiri Rural 

Within 

the 

premises 

7,371 2,830 293 21 206 3,872 149 - - - - 

Mangalagiri Rural 
Near the 

premises 
3,574 1,717 182 9 292 1,297 30 1 4 3 39 

Mangalagiri Rural Away 3,192 1,417 215 4 87 1,208 7 1 7 5 241 

Mangalagiri Urban Total 27,271 22,524 1,975 87 213 1,947 469 5 1 3 47 

Mangalagiri Urban 

Within 

the 

premises 

17,002 15,170 1,111 18 58 270 375 - - - - 

Mangalagir

i 
Urban 

Near the 

premises 
7,046 5,255 699 12 54 930 67 2 - 2 25 

Mangalagir

i 
Urban Away 3,223 2,099 165 57 101 747 27 3 1 1 22 

Mangalagir

i (M + OG) 
Urban Total 27,271 22,524 1,975 87 213 1,947 469 5 1 3 47 

Mangalagir

i (M + OG) 
Urban 

Within 

the 

premises 

17,002 15,170 1,111 18 58 270 375 - - - - 
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Mangalagir

i (M + OG) 
Urban 

Near the 

premises 
7,046 5,255 699 12 54 930 67 2 - 2 25 

Mangalagir

i (M + OG) 
Urban Away 3,223 2,099 165 57 101 747 27 3 1 1 22 


	Cover Pages
	Thesis Report

